
Tree Menu Magic 2 

Plant a grove of Tree Menus on your page today... 

 

Tree Menu Magic 2 automates the process of building collapsible, tree-style CSS-

based menus. You can add as many menus to the same page as you like. Each Tree 

Menu can be styled independently or you can have some, or even all, share the 

same style. The options for each Tree Menu are set independently, each with its 

own dedicated user interface. 

We hope you enjoy using this product as much as we did making it. 

Al Sparber & Gerry Jacobsen PVII 

  



 

2 Tree Menu Magic 2 | ©2010 Project Seven Development 

 

2 Tree Menu Magic 2 

Table of Contents 

Tree Menu Magic 2 .................................................................................................................................. 1 

Installation ................................................................................................................................................. 6 

Installing the full version .................................................................................................................. 6 

Installing the upgrade version ......................................................................................................... 6 

Before you begin ...................................................................................................................................... 7 

Work in a Defined Dreamweaver Web Site ................................................................................... 7 

Asset Folders......................................................................................................................................... 7 

Using Tree Menu Magic 2 ..................................................................................................................... 8 

Overview ................................................................................................................................................. 8 

Inserting a New Tree Menu ............................................................................................................. 10 

Modifying an Existing Tree Menu ................................................................................................. 11 

Managing the User Interface Items .............................................................................................. 12 

Menu Options ..................................................................................................................................... 16 

The Interface Control Buttons ....................................................................................................... 21 

Advanced Current Marker ................................................................................................................... 22 

Overview ............................................................................................................................................... 22 

Opening the Advanced Current Marker ...................................................................................... 23 

Modifying the Advanced Current Marker ................................................................................... 25 

Removing the Advanced Current Marker ................................................................................... 26 

Advanced Current Marker Link Text Marking Option ................................................................ 27 

Overview ............................................................................................................................................... 27 

Opening the Advanced Current Marker ...................................................................................... 27 

Select the Current Marker Option ................................................................................................. 28 

Select the Link Text .......................................................................................................................... 29 

Finished ................................................................................................................................................ 29 

  



 

3 Tree Menu Magic 2 | ©2010 Project Seven Development 

 

3 Tree Menu Magic 2 

Advanced Current Marker "Folder:Text Match" Option ............................................................. 30 

Overview ............................................................................................................................................... 30 

Opening the Advanced Current Marker ...................................................................................... 31 

Select the Current Marker Option ................................................................................................. 32 

Define the Folder Name :: Link Text Pairs ................................................................................. 32 

Adding another Folder Name :: Link Text Pair ......................................................................... 34 

Using a Compound Folder Name .................................................................................................. 35 

Ordering the Defined Pairs ............................................................................................................. 36 

Deleting a Defined Pair .................................................................................................................... 36 

Finished ................................................................................................................................................ 37 

Advanced Current Marker URL Match Option ............................................................................... 38 

Overview ............................................................................................................................................... 38 

Opening the Advanced Current Marker ...................................................................................... 39 

Select the Current Marker Option ................................................................................................. 40 

Select the URL to Match ................................................................................................................... 40 

Finished ................................................................................................................................................ 41 

Advanced Current Marker "None - Disable All" Option ............................................................. 42 

Overview ............................................................................................................................................... 42 

Opening the Advanced Current Marker ...................................................................................... 42 

Select the Current Marker Option ................................................................................................. 43 

Finished ................................................................................................................................................ 44 

PVII Tree Menu Magic 2 -Remove Menu ......................................................................................... 45 

Overview ............................................................................................................................................... 45 

Open the Remove PVII Tree Menu Magic 2 interface .............................................................. 45 

The Interface Control Buttons ....................................................................................................... 47 

  



 

4 Tree Menu Magic 2 | ©2010 Project Seven Development 

 

4 Tree Menu Magic 2 

Image File Naming Convention ......................................................................................................... 48 

Overview ............................................................................................................................................... 48 

Questions and Answers ....................................................................................................................... 51 

How are the Tree Menu Magic 2 CSS files and rules named? .............................................. 51 

How do I use or manage Menus in different folders? ............................................................ 53 

Can I Revert back to a default Style Theme CSS file? ............................................................. 55 

How do I use images for my links? .............................................................................................. 55 

How do I set font (typeface) styles for my menu? ................................................................... 56 

Can I set different font styles for my root and sub-menu items? ...................................... 57 

Can I use TMM 2 on the same page as TMM 1 - or with other PVII menus? .................. 57 

Can I update a Tree Menu Magic 1 menu to Tree Menu Magic 2? ..................................... 57 

Can I insert a menu inside an Accordion, Glide Panel, Elevator or Tab Panel widget? 58 

Can I edit the background images? ............................................................................................. 58 

How do I change the default or hover styles for my links? .................................................. 60 

How do I set the width of my menu? ........................................................................................... 60 

Why are my menu link colors not what I set them to be? ..................................................... 61 

How do I change the appearance of the Current Marked link that highlights the page 

you are on? .......................................................................................................................................... 63 

Can I style just the first or last link in a menu independently? ........................................... 64 

How do I style my trigger links? .................................................................................................... 65 

Are there other special CSS classes that can be used? .......................................................... 66 

Can I add more custom-styled levels to my Multicolor menu? ........................................... 67 

How can I adjust the indent of my sub-menus? ...................................................................... 71 

Can I use images for my menu items? ........................................................................................ 71 

  



 

5 Tree Menu Magic 2 | ©2010 Project Seven Development 

 

5 Tree Menu Magic 2 

My Image Swaps are not working or are showing broken images. What's wrong? ....... 72 

How can I make it so my sub-menus are hidden in Dreamweaver Design View? ......... 72 

Can I hide my sub-menus in Dreamweaver and still have an accessible site? ............... 72 

Is there a place on the PVII site where I can find more TMM2 examples or tweaks? ... 72 

Support and Contact info .................................................................................................................... 73 

PVII Knowledge Base ......................................................................................................................... 73 

 

  



 

6 Tree Menu Magic 2 | ©2010 Project Seven Development 

 

6 Installation 

Installation 

The installation procedure depends on whether you purchased the full version or 

the upgrade version. 

Installing the full version 

Look for the extension installer file p7_TMM2_217.mxp (or higher) in the root of 

the zip archive you downloaded. Double-click the file to install the extension. 

Dreamweaver's Extension Manager will open and you will be prompted to complete 

the installation. Once the installation is complete, restart Dreamweaver. 

OS X users: If, upon double-clicking the installer, Extension Manager does not properly launch, you have 

a file association issue. To remedy the problem locate the installer file from inside a Finder window and 

double-click it. 

Installing the upgrade version 

Using the upgrade version requires that Tree Menu Magic 1 is installed. Once you 

install the upgrade you will be able to use both Tree Menu Magic 1 and Tree Menu 

Magic 2. 

Look for the extension installer file p7_TMM2_217_upg.mxp (or higher) in the root 

of the zip archive you downloaded. Double-click the file to install the extension. 

Dreamweaver's Extension Manager will open and you will be prompted to complete 

the installation. Once the installation is complete, restart Dreamweaver. 

OS X users: If, upon double-clicking the installer, Extension Manager does not properly launch, you have 

a file association issue. To remedy the problem locate the installer file from inside a Finder window and 

double-click it. 
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Before you begin 

Work in a Defined Dreamweaver Web Site 

Before you begin, make sure you are working inside a defined Dreamweaver web 

site. This is necessary so that Dreamweaver knows how to link assets required by 

Tree Menu Magic 2 to your page. If you are new to Dreamweaver or need to learn 

how to define a web site, please see this tutorial: Defining a Dreamweaver Web Site. 

Asset Folders 

When you create a Tree Menu Magic 2 menu, the system creates an assets folder 

named p7tmm at the same level as the page that contains your menu. This folder 

will contain the Tree Menu Magic 2 JavaScript file and the relevant menu style 

sheet(s), as well as an img sub-folder that contains the background images for 

each style theme you are using. 

 

When you publish your site, make sure you upload the entire p7tmm folder. 

A Fireworks folder will also be created at the same level as the p7tmm folder and 

will contain editable versions of all necessary background images. The Fireworks 

folder does not need to be uploaded to your Web server. 

  

http://www.projectseven.com/products/menusystems/pmm/user_guide/getting_started/before_define.htm
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Using Tree Menu Magic 2 

Overview 

Tree Menu Magic 2 automates the process of building multi-level collapsible CSS-

based menus. You can add as many menus to the same page as you like. Each Tree 

Menu can be styled independently or you can have some, or even all, share the 

same style. The options for each Tree Menu are set independently—each with its 

own dedicated user interface. 

The Tree Menu Magic 2 user interface is designed to automatically open to the 

correct mode based on your current insertion point in the document. If your 

insertion point is inside an existing Tree Menu Magic 2 menu, the user interface will 

open in the Modify mode for that particular menu. If your insertion point is not 

within an existing Tree Menu Magic 2 menu, the user interface will open in the 

Create mode. 

Dreamweaver Template Support: The system is specifically designed to be 100% 

Dreamweaver Template friendly. You can insert one or more menus into a template 

(.dwt) page at any time. You can also insert one or more menus into a template-

based page. The system will automatically detect the template and adjust to allow 

insertion into an editable region.  

Current Link Marking: The system includes a built-in feature that highlights the link 

in the menu that matches the current page's URL (address). The system sets this 

link to a special style class named current_ mark, and will also apply another 

special class (li_current_mark) to the link's parent <li> tag. This provides a visual 

trail to the current page in the menu—a "you are here" indicator. This feature can 

easily be turned on or off for each menu on your page directly from the user 

interface. Additionally, the system includes an Advanced Current Marker system to 

allow you to set the current mark for pages that do not appear as links in the menu. 
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Image Support: The Tree Menu magic 2 system fully supports using images for any 

root or sub-level links. The Tree Menu Magic 2 system is designed to automatically 

handle preloading, swapping, multiple state management and current marking. 

This automation requires that you follow the image file name convention discussed 

later in this guide. The system supports up to 4 different image states. 

First and Last Menu Link Styling: The system automatically assigns a special CSS 

class to the first and last links in the menu in order to facilitate styling that requires 

exception rules for these links. The tmmfirst class is assigned to the first link (and 

also to its <li> parent tag) in the menu and the tmmlast class is assigned to the 

last link (and its <li> parent tag) in the menu. 

Note: The Tree Menu Magic 2 system assigns appropriate style classes to all of the necessary elements 

dynamically, based on the options selected. These classes are not available in Dreamweaver Design View. 

You will need to preview the page in a browser (or CS 4 Live View) to see the rendered effects of these 

style assignments. 

The Tree Menu Magic 2 system also includes a handy Remove Tree Menu command 

that can be used to quickly remove a menu and its associated markup from your 

page. 

Insertion 

Tree Menu Magic 2 menus can be inserted anywhere on your page. Once you have 

established your insertion point, click the Tree Menu icon to open the interface. 

Alternatively, you can choose Insert > Studio VII > Tree Menu Magic 2 by PVII. You 

can insert the menu into any area of your page. The menu width will automatically 

adapt to its location, even when placed inside flexible DIVs or table cells. You can 

insert as many individual menus as you like on your page. Each menu can be 

optioned independently to set different behaviors and features. Menus on a single 

page can share the same style theme or be set to separate style themes. 
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Inserting a New Tree Menu  

-Establish the insertion point for your new menu by clicking in the area of the page 

where you would like it to be created.  

Note: The interface is sensitive to the insertion point. If your cursor is currently inside an existing Tree 

Menu component then the Modify interface will open instead.  

-Click the Tree Menu Magic 2 icon  in the Common Section of Dreamweaver's 

Insert Bar or choose Insert > Studio VII > Tree Menu Magic 2 by PVII. 

Classic Dreamweaver Insert Bar 

 

Dreamweaver CS4 Insert Panel 

 

Dreamweaver CS4 Users: We highly recommend switching to Classic Workspace mode, which allows for 

a conventional Insert Bar across the top of your Design View window. If you use the new CS4 workspaces, 

the Insert Bar becomes a vertical panel that violates Windows and OS X interface conventions. In addition 

to being hard to use, the vertical Insert Bar has no support for mouse wheel scrolling making it highly 

unusable. We are hoping Adobe will fix this (and other) UI issues in the next version of Dreamweaver. 
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The Tree Menu Magic 2 user interface will open in the Create New Tree Menu mode.  

 

You can create more than one menu on your page. Add as many as you like. 

Modifying an Existing Tree Menu 

You can modify any of the existing Tree Menu Magic 2 menus on your page at any 

time. 

-Click inside the menu that you wish to modify. 

-Click the Tree Menu Magic 2 icon  in the Common Section of Dreamweaver's 

Insert Bar or choose Modify > Studio VII > Modify Tree Menu Magic 2 by PVII 
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The Tree Menu Magic 2 User Interface will open in the Modify Existing Tree Menu 

mode. 

 

Managing the User Interface Items 

Mode 

Displays the current operational Mode for the user interface: either Create or 

Modify. When in Modify mode, the id of the menu being modified will also be 

displayed. 

Menu Items 

This box displays the text for each navigation link in the menu—one line for each 

link. Select (click) the line you wish to act on. 
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Add Item 

Click the Add Item button to add a new menu link. This new item will be created 

immediately after the selected item, and at the same level as the selected item. The 

newly created menu item will initially appear with the default description: Menu 

Item and the URL will simply be a hash (#) placeholder. Change these to suit your 

needs. The Image Path box is always blank by default.  

Add Sub 

Click the Add Sub button to create a new sub-menu for the selected root link item. 

A new menu item will appear directly beneath the selected menu item, indented 

one level. The newly created menu item will initially appear with the default 

description: Menu Item and the URL will simply be a hash (#). Change these to suit 

your needs. The Image Path box is always blank by default. 

Delete 

Click the Delete button to remove the selected menu item. If the menu item 

contains one or more sub-menu levels the system will completely remove the 

selected menu item and all of its sub-menu levels. 

Note: The interface requires at least one item to be in the menu list at all times. The system will not allow 

you to delete a menu item if it is the only remaining one. 

Up 

Click the Up button to move the selected menu item up in the Menu Items list. The 

menu item, and all of its sub-menu items, will be moved up one position each time 

the button is clicked. If the menu section before the selected item is in the open 

state (sub-menu items showing) then the selected menu item will be moved to the 

last position of the open menu section. 
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Down 

Click the Down button to move the selected menu item down in the Menu List. The 

menu item, and all of its sub-menu items, will be moved down one position each 

time the button is clicked. If the menu section after the selected item is in the open 

state (sub-menu items showing) then the selected menu item will be moved to the 

first position of the open menu section. 

Item Link Text 

The Menu Link Text box will always display the text of the currently selected line in 

the Menu Items list. Enter or edit the text that you wish to display for this menu 

link. The box cannot be left blank. 

Note: If an image has been assigned, this box will be disabled (grayed out) and contain the file name of 

the assigned image. Removing the Image Path will re-enable this box. 

Link Path/ Browse...  

Enter the path to the linked page for this menu item or use the Browse button to 

open the Select File to Link dialog box. The system will automatically supply a "#" 

link placeholder when new menu items are created, which you should change to an 

actual page link before publishing. 

Image Path / Browse... 

Note: The Image Path box is only used if you are using images for your menu buttons. For text-based 

menus this box should be left empty.  

Enter the path to your menu button image, or use the Browse button to open the 

Select Image Source dialog box. You can change the image at any time by selecting 

the menu item and clicking the Browse... button. Valid image types are: .gif, .jpg, 

.jpeg, and .png. 
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The image you select must always be the default button image. The system will 

handle image preloading for rollover, down-state and current mark images based 

on the Image Swap Option you select. The file names of your button images can be 

anything you like. However, you must follow a naming convention for the swap 

images. This naming convention is also user-definable to allow easy configuration 

with the output of your image editor. 

Image Alt Text 

Enter a description (Alt Text) for the related image button. If the text on the button 

is "Products" then Products would be a good choice for the description. 
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Menu Options 

These settings are applied to the current Tree Menu Magic 2 menu. Other menus on 

the same page can have different options.  

Trigger Action 

The Tree Menu Magic 2 system allows you to control how the menu responds 

whenever a section trigger is clicked. 

Allow Page Link on Trigger 

This option controls how the Tree Menu will respond when a section trigger link (a 

menu item that contains one or more sub-menus) is clicked. When this option is 

unchecked the system will always open or close the related sub-menu. When this 

option is checked then the system will first check to see if there is a valid page link 

assigned to the trigger link and, if there is, the system will process the link and 

allow the browser to open the linked page. This option is useful when you have 

section intro pages. 

Toggle Sub-Menus 

With this option selected, the system will automatically close any open menu 

sections when another menu section is opened. With this option unchecked, the 

system will open or close sub-menus only when the user clicks on a menu trigger. 

Page Load 

The Tree Menu Magic 2 system includes several handy options that control how the 

menu will deploy when the page first loads into the browser. 
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Open Sub-Levels 

You can have the menu start initially with all (or some) of the sub-menus in the 

opened state. Check this box if you want the sub-menu to be in the open state. The 

Open to Level selection will become active, and then you simply select the number 

of sub-menu levels you wish to be opened. 

Open to Level 

Select the number of sub-menu levels that you wish to have in the open state when 

the menu first loads into the browser. You can select All Levels or any number of 

levels. This option will be grayed out (disabled) unless the Open Sub-Levels box is 

checked. 

Include Open All/Close All Links 

Check this box if you wish to have the system create Open All and Close All links. A 

separate <div> named "p7TMM_Xoc" will be created to house these control links, 

where X represents the number of the Tree Menu Magic system on the page. You 

can remove this <div> at any time by un-checking this box. These links will not be 

visible in Dreamweaver but will appear in your browser. 
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Image Swap Options 

The Tree Menu Magic 2 system supports using images in any of the root level or 

sub-menu links. The Tree Menu Magic 2 system is designed to automatically 

handle all of the required image actions, such as preloading, swapping, maintaining 

down state, and maintaining a current marker state. This automation requires that 

you follow the image file name convention. The system supports up to 4 different 

image states. Select the Swap Option that that you would like to use: 

Single Image Only 

Choose this option if you are using just a single image and do not want any image 

swap actions on any of the menu states.  

Normal and Over 

Choose this option if you are using two images: one normal image and one for the 

over (hover) state. The over state image will also be used as the open (down) state 

and current mark images. 

Normal, Over and Open Images 

Choose this option if you are using three images: one normal image, one for the 

over (hover) state, and one for the open (down) state. The open state image will be 

used for the current marker images. 

Normal, Over, Open and Mark 

Choose this option if you are using four images: one normal image, one for the 

over (hover) state, one for the open (down) state, and one for the current marker 

state. 

Note: Be sure to choose the option carefully to match the number of image states you are using. The 

system will pre-load the various state images based on this selection. 
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Rollover Open State 

This controls the swap action taken when the menu item is in its open state. 

Normally, the system will not swap to the over image if the menu item is in the 

open state. Check the box if you want to enable this swap action. 

Rollover Mark State 

This controls the swap action taken when the menu item is in its current marked 

state. Normally, the system will not swap to the over image on rollover if the menu 

item is in the current marked state. Check this box if you want to enable the 

rollover. 

Use Current Marking 

Check this box to enable the automatic current marking of links in the menu. This 

box must be checked in order to use the Advanced Current Marker features for the 

menu. 

Include URL Parameters in Match 

This option controls whether the automatic current marking feature will include any 

URL parameters in the page's address when looking for a matching link in the 

menu. Check this box if you wish to have your URL parameters included in the 

match criteria. 
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Animation Method 

The Tree Menu Magic 2 system allows you to choose the type of animation to use 

when opening a sub-menu: 

 0-None -Choose this option if you do not wish to have any animated effects.  

 1-Reveal Down -The sub-menu will reveal itself in a downward direction. 

 2-Reveal Right - The sub-menu will reveal itself in a left to right direction. 

 3-Reveal Down and Right -A combination of both animations. The sub-menu 

level will open downward to create a space for the sub-menu, which will then 

be revealed in a left to right direction. 

Glide Duration 

This option allows you to control speed for the Glide animation. Duration defines 

the total amount of time that the animation will run, in milliseconds, regardless of 

a sub menu's dimensions. The default 150 is fine in most cases. Lower the 

Duration setting and the animation will be faster. Raise the setting to make the 

animation slower. 

Note: This option has no effect on the Reveal Right animation. 

Style Theme 

Tree Menu Magic 2 comes with pre-defined CSS style themes. Choose a theme that 

best approximates the look you desire. This will act a starting point from which you 

can later make edits to the style sheet to fully customize your menu(s). You can 

change to a different style theme at any time without affecting the contents of your 

menus.  

A preview of the selected theme is displayed to the right of the Style Theme select 

list. This Preview will change whenever you select a different theme. 
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The Interface Control Buttons 

OK 

When you are done setting your desired options, click the OK button to build the 

menu. The system will verify your selections and alert you to any problems that 

need your attention. If there are no problems, the interface will close and a menu 

will be added to your page or updated—depending on whether you are in Create 

mode or Modify mode. You can then preview in a browser to operate the menu and 

check its functionality.  

Tip: To make further changes, click inside a menu and then open the Tree Menu Magic 2 interface to 

begin your modifications. 

Cancel 

Click the Cancel button to completely abort the current Tree Menu Magic 2 

operation. This will close the interface and no changes will be made to your page. 

Help 

Click the Help button to open the associated Help File in your browser. This page 

can remain open for easy reference while you continue working with the Tree Menu 

Magic 2 interface. 
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Advanced Current Marker 

Overview 

The Tree Menu Magic 2 system includes a built-in feature that applies a Current 

Marker to the link in the menu that matches the current page's URL. The system 

sets this link to a special style class named current_mark. This provides a visual 

trail to the current page in the menu—a you are here indicator. This feature can be 

turned on or off by setting the Enable Auto Current Marking box in the user 

interface for each menu on the page. 

This default Current Marker feature works automatically, without user 

intervention—but it does rely on matching the current page's URL to the hyperlinks 

contained in the menu. In most cases this will work just fine. However, when the 

current page is not reflected as a link in the menu, the current marker will not be 

able to find a match and no marker is applied. Fortunately, Tree Menu Magic 2 

includes an Advanced Current Marker system to allow you to handle these 

exceptions so that even pages that do not appear in the menu can have a specified 

menu link Current Marked. 

Note: Use the Advanced Current Marker ONLY when the page does NOT appear as a link within the menu 

system. In other words, the Advanced Current Marker is designed to handle the exceptions that go beyond 

the capabilities of the default current marking feature. 

The Advanced Current Marker system is designed to be 100% Dreamweaver 

Template friendly. It can be applied to any template or template-based page. The 

system will detect the page type and process accordingly.  
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Opening the Advanced Current Marker 

To open the interface: 

-Click inside the Tree Menu Magic 2 menu that you wish to act on. 

-Choose Commands > Studio VII > Tree Menu Magic 2 by PVII > Advanced Current 

Marker... 

 

Note: The Advanced Current Marker option will be unavailable (grayed out) if there is no Tree Menu Magic 

2 html markup on the page or if you have not clicked on the menu you wish to act on. 

The Advanced Current Marker user interface will open.  
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The interface allows you to manage each of four options and also allows you to 

Remove an existing Advanced Current Marker. 

To activate the Advanced Current Marking feature you simply click the radio button 

next to the option you wish to use: 

1. Using the None Option  

2. Using the Text Link Option  

3. Using the URL Match Option  

4. Using the Folder/Text Option  
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Modifying the Advanced Current Marker 

The system also includes the ability to modify the parameters of a page that already 

has one of the Advanced Current marker options applied. 

On a page that already contains an Advanced Current Marker... 

-Click inside the menu that you wish to act on. 

-Choose Commands > Studio VII > Tree Menu Magic 2 by PVII > Advanced Current 

Marker... 

The interface will open in Modify mode. 

Note: When the Advanced Current Marker interface is in Modify mode, a Remove button appears in the 

column of command buttons on the right edge of the interface window. 

 

In this example, the interface opens with the URL option selected. The system will 

detect which option is being used on the page and set the interface accordingly. 
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Removing the Advanced Current Marker 

The Advanced Current Marker system includes a handy Remove utility that allows 

you to quickly remove an existing Advanced Current Marker from any page. If the 

system detects an Advanced Current Marker on your page, it will open in Modify 

mode - in which case, a Remove button will be present below the OK button.  

-Click the Remove button. 

 

The system will completely remove the Advanced Current Marker settings from your 

page. 
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Advanced Current Marker Link Text Marking Option  

Overview 

The Link Text option allows you to select the text of any one of the existing links in 

your Tree Menu Magic 2 menu as the target for the current marker. When the page 

loads, the system will look for this text in the menu markup. If a match is found it 

will apply the current marker style class (current_mark) to the menu link and will 

also apply the (li_current_mark) class to the link's parent <li> tag. 

This feature should only be used on pages that are NOT linked in the menu. The 

Advanced Current Marker is designed to address current marking only for those 

pages that are not represented in the menu. If the page does have a corresponding 

link in the menu then that link will be used by the default current marker instead. 

Opening the Advanced Current Marker 

To open the interface: 

-Click inside the Tree Menu Magic 2 menu that you wish to act on. 

-Choose: 

Commands > Studio VII > Tree Menu Magic 2 by PVII > Advanced Current Marker... 

 

Note: The Advanced Current Marker option will be unavailable (grayed out) if there is no Tree Menu Magic 

2 html markup on the page or if you have not clicked on the menu you wish to act on. 
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The Advanced Current Marker user interface will open.  

 

The interface has four options from which to choose. The radio button to the left of 

each option determines which option is currently active. The default setting is 

always the second option. 

Select the Current Marker Option 

-Click on the second radio button to select the Link Text option. 
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Select the Link Text 

The Link Text option includes a drop down listing of all of the links in your menu.  

For this example, let's assume that you want to highlight the root menu link that 

contains Page Three as its text. 

-Select Page Three from the drop down list. 

 

This tells the system to look for the item in the menu that contains Page Three as 

its text. When found, the system will apply the special current marker style class to 

it. 

Finished 

-Click the OK button to apply the selected Advanced Current Marker to the current 

page.  

 

-You can preview and test the menu now. 

Note: If your preferences are set to Preview using temporary file, this feature will not work locally. To 

preview locally, turn off the Preview using temporary file option in Dreamweaver Preferences. 
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Advanced Current Marker "Folder:Text Match" Option 

Overview 

The Folder:Text Match option is designed to allow you to handle large numbers of 

current marker exceptions and is typically used as a global option applied to every 

page. Use this option when you have a large number of pages that are not 

represented in the menu.  

This option allows you to specify a series of folder names and link text values that 

the system will use for determining the current marked link in the menu. For 

example, you can specify that any page which contains the folder "support" in its 

URL will be matched to specific link text "Information". This is referred to as a 

Folder Name :: Link Text pair.  

You can specify as many of these Folder Name :: Link Text pairs as you like. The 

system will test each pair until it finds a match. If a match is found it will apply the 

current marker style class, current_mark, to the menu link to provide the "you are 

here trail" in the menu. You can use this system to automatically handle current 

marking for all of your site's pages without having to edit any of them individually.  

This feature should only be used on pages that are NOT linked in the menu. The 

Advanced Current Marker is designed to address current marking only for those 

pages that are not represented in the menu. If the page does have a corresponding 

link in the menu then that link will be used by the default Current Marker instead. 
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Opening the Advanced Current Marker 

To open the interface: 

-Click inside the Tree Menu Magic 2 menu that you wish to act on. 

-Choose Commands > Studio VII > Tree Menu Magic 2 by PVII > Advanced Current 

Marker... 

 

Note: The Advanced Current Marker option will be unavailable (grayed out) if there is no Tree Menu Magic 

2 html markup on the page or if you have not clicked on the menu you wish to act on. 

The Advanced Current Marker user interface will open.  

 

The interface has four options from which to choose. The radio button to the left of 

each option determines which option is currently active. The default setting is 

always the second option. 
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Select the Current Marker Option 

-Click on the fourth radio button to select the Folder Name :: Link Text option. 

 

The interface allows you to add as many Folder Name :: Link Text pairs as you like. 

The first pair is always pre-defined and ready for editing.  

Define the Folder Name :: Link Text Pairs  

This example will work with a menu system that resembles the structure of the 

menu on projectseven.com. There is a single Extensions link in the root menu of all 

interior pages, but there are quite a few pages (close to one hundred) that are 

related to Extensions and stored in a folder named extensions. Naturally, all of 

these pages do not appear in the menu. A Folder Name :: Link Text rule can be 

defined to apply the current marker to the Extensions link for any page that 

contains "extensions" in the page's URL. 

Specify the Folder Name 

The folder name is case sensitive and should match the actual folder name as used 

in your site. 

-Enter the folder name extensions into the If URL contains this Folder Name box. 
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Specify the Link Text 

The Mark this Link Text list is an alphabetized listing of all of the links in the menu. 

-Select the Extensions link text. 

 

The interface now reflects your changes. The first Folder Name :: Link Text pair is 

defined.  

 

The system will apply the current marker to the Extensions menu item whenever 

the page contains the extensions folder in its address (URL).  
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Adding another Folder Name :: Link Text Pair 

The site contains many pages that relate to the Products section but are not 

represented as links in the menu. To handle these pages you can add another 

Folder Name :: Link Text pair. 

-Click the Add button. A new Folder Name :: Link Text line item is created in the 

interface. The values are preset to default values, ready for editing.  

 

-Enter the folder name, products, into the If URL contains this Folder Name box. 

-Select the Products link text in the Mark this Link Text drop down. 
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The interface now reflects your changes. Two Folder Name :: Link Text pairs are 

defined.  

 

Using a Compound Folder Name 

The site also contains sub-folders in the products area. You can define a compound 

folder name to allow a set of pages to current mark a more specific link. 

-Click the Add button. 

A new Folder Name :: Link Text line item is created in the interface. 

-Enter the folder name, products/menusystems into the If Url contains this Folder 

Name box. 

 

This will instruct the system to apply the current mark to the Menu Systems menu 

item whenever the page contains products/menusystems in its URL.  
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Ordering the Defined Pairs 

The system will apply the current mark to the first match it finds. It will search in 

the same order as the pairs are listed in the interface. In this case it will always find 

the products match before it finds the compound products/menusystens match 

since the page URL contains the word products and the products pair is listed 

before the products/menusystems pair.  

-With the products/menusystems pair selected, click the Up button. 

 

The system moves the selected item up one line. Now the search for the compound 

folder name will be made before the search for the products folder name. 

You can move any selected line Up or Down. Each time the button is clicked the 

selected item will move one line. 

Deleting a Defined Pair 

You can delete an existing defined Folder Name :: Link Text pair at any time. Select 

the Folder Name :: Link Text pair you wish to delete and simply click the Delete 

button. 
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Finished 

-Click the OK button to apply the selected Advanced Current Marker to the current 

page.  

 

-You can preview and test the menu now. 

Note: If your preferences are set to Preview using temporary file, this feature will not work locally. To 

preview locally, turn off the Preview using temporary file option in Dreamweaver Preferences. 

  



 

38 Tree Menu Magic 2 | ©2010 Project Seven Development 

 

38 Advanced Current Marker URL Match Option 

Advanced Current Marker URL Match Option  

Overview 

The URL Match option allows you to select the link value (the href) of any one of the 

existing links in the Tree Menu Magic 2 system as the target for the current marker. 

When the page loads, the system will look for this link value in the menu markup. If 

a match is found it will apply the current marker style class (current_mark) to the 

menu link and will also apply the (li_current_mark) class to the link's parent <li> 

tag. 

The simplest and most direct method for Advanced Current Marking is to use the 

Text Option. However, there may be occasions where you have duplicate text values 

in the menu. In these cases, you can use the URL match option to target a specific 

link for current marking. 

This feature should only be used on pages that are NOT linked in the menu. The 

Advanced Current Marker is designed to address current marking only for those 

pages that are not represented in the menu. If the page does have a corresponding 

link in the menu then that link will be used by the default current marker instead. 
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Opening the Advanced Current Marker 

To open the interface: 

-Click inside the Tree Menu Magic 2 menu that you wish to act on. 

-Choose Commands > Studio VII > Tree Menu Magic 2 by PVII > Advanced Current 

Marker... 

 

Note: The Advanced Current Marker option will be unavailable (grayed out) if there is no Tree Menu Magic 

2 html markup on the page or if you have not clicked on the menu you wish to act on. 

The Advanced Current Marker user interface will open.  

 

The interface has four options from which to choose.  
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The radio button to the left of each option determines which option is currently 

active. The default setting is always the second option. 

Select the Current Marker Option 

-Click on the third radio button to select the URL Match option. 

 

Select the URL to Match  

The URL Match option includes a drop down listing of the link values (href) for all of 

the links in your menu.  

For this example, let's assume that you have a page that pertains to the "Products" 

section of your site, but this page is not represented as an item in the menu. Your 

products section is represented in the menu with a link (href) value of 

page_three.htm.  

-Select page_three.htm in the listing. 

 

This tells the system to look for the link value (href) in the menu that contains 

page_three.htm. When it's found, the special current marker style class is assigned 

to it. 
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Finished 

-Click the OK button to apply the selected Advanced Current Marker to the current 

page.  

 

-You can preview and test the menu now. 

Note: If your preferences are set to Preview using temporary file, this feature will not work locally. To 

preview locally, turn off the Preview using temporary file option in Dreamweaver Preferences. 
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Advanced Current Marker "None - Disable All" Option 

Overview 

The None - Disable All option allows you to completely turn off all current marking 

for this menu on this page only. This is a special override that allows you to have 

the menu working with current marking turned off on a specific page while it is 

enabled on other pages. 

Opening the Advanced Current Marker 

To open the interface: 

-Click inside the Tree Menu Magic 2 menu that you wish to act on. 

-Choose Commands > Studio VII > Tree Menu Magic 2 by PVII > Advanced Current 

Marker... 

 

Note: The Advanced Current Marker option will be unavailable (grayed out) if there is no Tree Menu Magic 

2 html markup on the page or if you have not clicked inside the menu you wish to act on. 
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The Advanced Current Marker user interface will open.  

 

The interface has four options from which to choose. The radio button to the left of 

each option determines which option is currently active. The default setting is 

always the second option. 

Select the Current Marker Option 

-Click on the first radio button to select the None -Disable All Current Marking 

option. 
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Finished 

-Click the OK button to apply the selected Advanced Current Marker to the current 

page.  

 

-You can preview and test the menu now. 

Note: If your preferences are set to Preview using temporary file, this feature will not work locally. To 

preview locally, turn off the Preview using temporary file option in Dreamweaver Preferences. 
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PVII Tree Menu Magic 2 -Remove Menu 

Overview 

The Tree Menu Magic 2 system includes a Remove feature that allows you to 

quickly remove an existing Tree Menu Magic 2 menu from your page. 

Open the Remove PVII Tree Menu Magic 2 interface 

-Open a page that contains one or more Tree Menu Magic 2 menus. 

-Choose Commands > Studio VII > Remove Tree Menu Magic 2... to open the 

Remove interface.  

 

Note: The Remove option will be unavailable (grayed out) in the menu if there is no Tree Menu Magic 2 

menu on the page.  

The Remove Tree Menu Magic 2 interface will open. 

 

The interface will provide a listing of all of the Tree Menu Magic 2 menus on your 

page. The list will display the ID of each menu.  
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-Select the menu that you wish to remove from the listing. You can remove one 

menu at a time. 

Tip: If you are unsure about which menu relates to which ID, click the Cancel button and switch to Code 

View. In Code View, locate all IDs that begin with p7TMM. The opening DIV tag for a Tree Menu Magic 2 

menu looks like this: <div id="p7TMM_1" class="p7TMM01"> 

What will be removed  

The system will completely remove the html markup for the selected menu from 

your page. If there are other Tree Menu Magic 2 menus on the page they will not be 

affected. The system will also remove the link to the relevant CSS file if no other 

menu on the page is using the same style theme. 

If there are no remaining Tree Menu Magic 2 menus on your page, the system will 

also remove the link to the Tree Menu JavaScript file. 

What will not be removed 

The system will not remove the p7TMM folder, which contains the menu-related 

assets (images, JavaScript file, and CSS files). This ensures that you will not lose any 

assets you may have modified and any other pages that depend on those modified 

assets will continue to look and behave as expected. 
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The Interface Control Buttons 

Remove 

Click the Remove button. The selected Tree Menu Magic 2 menu will be removed 

from the page 

Cancel 

Click the Cancel button to completely abort the current Remove Tree Menu Magic 2 

operation. This will close the interface and no changes will be made to your page. 

Help 

Click the Help button to open the associated Help File in your browser. This page 

can remain open for easy reference while you continue working with the Tree Menu 

Magic 2 interface. 
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Image File Naming Convention 

Overview 

The Tree Menu magic 2 system fully supports using images for any root or sub-

level links. The Tree Menu Magic 2system is designed to automatically handle 

preloading, swapping, multiple state management and current marking.  

The system supports up to 4 different image states: 

 Normal - the base image 

 Over - appears on mouse hover 

 Open - appears when the trigger’s related sub menu is open 

 Mark - appears when the menu item has been current marked 

The system handles the state of each image automatically based on the Image Swap 

option you choose in the User Interface.  

You do not need to use all four states. You can choose to use a single image or 

two-state, three-state or four-state image swaps. This automation requires that 

you follow the image file name convention. The file names of your button images 

can be anything you like. However, you must follow a naming convention for the 

"over", "open" and "mark" images. For example, if you name your default button 

image myButton.gif... 

 The image you want to appear when users mouse over it would be: 

myButton_over.gif  

 The image you would want to designate the open state would be named: 

myButton_overdown.gif 

 The image you want to designate as the current marked state would be: 

myButton_down.gif. 

Note: While the Swap Options can be set differently for each Tree Menu Magic 2 system on the page, the 

naming convention is global and will be used for all of the Tree Menu Magic 2 systems on your page. 
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Default Naming Convention: 

 Normal Image: myButton.gif 

 Over Image: myButton_over.gif 

 Open Image: myButton_overdown.gif 

 Mark Image: myButton_down.gif 

The default naming convention is designed to work with the default Fireworks (CS4) 

naming convention for the over, open and mark images. This naming convention is 

also user-definable to allow synching with your image editor's capabilities or your 

own requirements. The basic image name must be the same for all four button 

images, but the appendage you use to differentiate the rollover, open and mark 

images can be anything you like. 

Changing the image naming convention 

1. Open the p7TMMscripts.js file located in the p7tmm folder. Near the top of the 

file you will see 3 lines (not counting the comments): 

// define the image swap file naming convention 

// rollover image for any image in the normal state 

var p7TMMover='_over'; 

// image for any trigger that has an open sub menu -no rollover 

var p7TMMopen='_overdown'; 

// image to be used for current marker -no roll over 

var p7TMMmark='_down'; 
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2. To change the naming convention simply change the assigned text that follows 

the equal (=) sign in each of the three lines.  

For example, if you want to change the naming convention to use the appendages 

_over, _open, and _marked, change the assignments so they look like this: 

// define the image swap file naming convention 

// rollover image for any image in the normal state 

var p7TMMover='_over'; 

// image for any trigger that has an open sub menu -no rollover 

var p7TMMopen='_open'; 

// image to be used for current marker -no roll over 

var p7TMMmark='_marked'; 

3. Save and close the file. 

Now the Tree Menu Magic 2 system will use this revised naming convention to 

locate the over, open and mark state images. The image file names, using this 

customized naming convention, would look like: 

 Normal Image: myButton.gif 

 Over Image: myButton_over.gif 

 Open Image: myButton_open.gif 

 Mark Image: myButton_marked.gif 

As you can see, any naming convention will work by managing the text assignment 

for each image state in the scripts file. 

Note: If you create a menu in another folder or site, and you want to use a revised naming convention, you 

will need to update the scripts file in that folder. 
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Questions and Answers 

The following questions and answers should prove helpful as you build and manage 

your menus. 

How are the Tree Menu Magic 2 CSS files and rules named? 

The CSS files follow a naming convention based on the Style Theme you have 

chosen. Here is a reference list for you: 

 01-Basic | p7TMM01.css 

 02-See-Through | p7TMM02.css 

 03-Cayenne | p7TMM03.css 

 04-Carbon | p7TMM04.css 

 05-Greystone | p7TMM05.css 

 06-Chili | p7TMM06.css 

 07-Image-Based | p7TMM07.css 

 08-Topaz | p7TMM08.css 

 09-Multicolor | p7TMM09.css 

 10-Classic | p7TMM10.css 

 11-Neon Right Aligned | p7TMM11.css 

 12-Neon Left Aligned | p7TMM12.css 
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The selector names inside each CSS file are all prefaced with the class name 

assigned to the root menu DIV. This class name matches the name of the CSS file 

used. Here is a reference list of the class name selectors: 

 01-Basic | .p7TMM01 

 02-See-Through | .p7TMM02 

 03-Cayenne | .p7TMM03 

 04-Carbon | .p7TMM04 

 05-Greystone | .p7TMM05 

 06-Chili | .p7TMM06 

 07-Image-Based | .p7TMM07 

 08-Topaz | .p7TMM08 

 09-Multicolor | .p7TMM09 

 10-Classic | .p7TMM10 

 11-Neon Right Aligned | .p7TMM11 

 12-Neon Left Aligned | .p7TMM12 

As we discuss CSS style editing from this point on, we will refer to style rule names 

(selectors) as beginning with .p7TMMxx where xx is the style theme number (01 or 

05, for example) 
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How do I use or manage Menus in different folders? 

When you create a menu, the system writes a folder named p7tmm and a Fireworks 

folder in the folder that contains the page you are working on - and uses that 

folder to store style sheets, images, and scripts. This allows for easy and safe 

prototyping. If you create a menu on page1.htm, in a folder named tutorials, and 

edit the CSS for that menu, your changes are restricted to that folder. Make another 

page in that folder and create a menu using the same Style Theme and it will use 

the same style sheet you edited while working on page1. If you create a menu on a 

page in a new folder, the system will create new p7tmm and Fireworks folders 

inside that folder and populate it with default style sheets, scripts, and images. This 

allows you to test and prototype with complete freedom - without affecting 

finalized pages in other folders. 

There may, however, be times when you want menus in different folders to use the 

same style sheets. To do that, create your menus first. Then decide which p7tmm 

assets folder you want to use for all your pages. You'll need to set the paths for all 

Tree Menu Magic 2 CSS files, and the JavaScript file, to point to the p7tmm assets 

folder you want to use.  

  



 

54 Tree Menu Magic 2 | ©2010 Project Seven Development 

 

54 Questions and Answers 

For a page with both a Cayenne menu, the CSS and script links look like this: 

<script type="text/javascript" src="p7tmm/p7TMMscripts.js"></script> 

<link href="p7tmm/p7TMM03.css" rel="stylesheet" type="text/css" media="all" /> 

You can change the path to CSS or script files visually in Dreamweaver by displaying 

Head Content in a toolbar at the top of your design window. To turn this feature on, 

choose View > Head Content. 

 

Click the appropriate icon and your Property Inspector will change to reflect your 

choice, easily enabling you to browse to the location of the assets folder you want 

to use. 
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Can I Revert back to a default Style Theme CSS file? 

Should you ever make a large error and need to revert back to a default and 

working CSS file, do this:  

1. Delete the bad CSS file from your p7tmm folder 

2. Open a page in that folder that contains a menu that uses that bad style 

sheet. Your menu will appear unstyled. Don't worry, that's expected, given 

the circumstances 

3. Place your cursor inside the menu 

4. Open the Tree Menu Magic 2 UI in Modify Mode 

5. Make no changes in the UI - simply click the OK button 

6. The system will create a new version of the appropriate CSS file 

Depending on your DW version, you might not see the changes at first. If that be 

the case, save and close the file, then re-open it. 

How do I use images for my links? 

To use images for your menu items you should first prepare your images and save 

them in a folder within your defined Web site—using our naming convention. With 

your images ready, select the special Image-Based Style Theme in the TMM2 

interface and insert your images by browsing to them. 
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How do I set font (typeface) styles for my menu? 

If you'd like to edit the font styles for your menu, open Dreamweaver's CSS Styles 

panel and locate the .p7TMMxx rule in your menu style sheet(s) (where xx 

corresponds to the Style Theme of your menu). You'll find the following 2 

declarations in the rule: 

font-size: inherit; 

font-family: Arial, Helvetica, sans-serif; 

Change them to suit your needs. 

Tip: font-size: inherit simply means that the menu font-size will be inherited from the parent elements on 

your page. If you place the menu inside a container that has a font-size set, the menu will inherit that value. 
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Can I set different font styles for my root and sub-menu items? 

Yes. You would use this rule for the top-level: 

.p7TMMxx { 

font-family: Arial, Helvetica, sans-serif;  

font-size: inherit; 

} 

The inherit value means the font-size will inherit the same value that is applied to 

the element in which your menu was inserted. Of course, you can assign a specific 

fixed (px) or proportional (em or percent) value if you wish. 

And this rule exists to make the sub-menu font-size 90% as large as the top-level 

menu items: 

.p7TMMxx ul ul a { 

font-family: "Courier New", Courier, monospace; 

font-size: 90%; 

} 

Can I use TMM 2 on the same page as TMM 1 - or with other PVII 

menus? 

Yes. You can use TMM 2 and any other PVII menu product on the same page. 

Can I update a Tree Menu Magic 1 menu to Tree Menu Magic 2? 

No. The markup for the 2 products is different. You may continue to use Tree Menu 

Magic 1 to manage your existing menus or you may remove the Tree Menu Magic 1 

menu on your page and insert a Tree Menu Magic 2 menu in its place. 

  

http://www.projectseven.com/products/menusystems/index.htm


 

58 Tree Menu Magic 2 | ©2010 Project Seven Development 

 

58 Questions and Answers 

Can I insert a menu inside an Accordion, Glide Panel, Elevator or Tab 

Panel widget? 

Yes. You can insert one or more menus inside the content panels of an Accordion 

Panel Magic, Glide Panel Magic, Elevator Panel Magic, or Tab Panel Magic widget. 

Can I edit the background images? 

Yes. When you create a menu, the system will also create a Fireworks folder 

containing the editable background images for your menu. Fireworks is the default 

web image editor for all Adobe® Creative Suite products. 

Tip: We suggest that you do not change the size of these images unless you really know what you are 

doing.  

The icons are assigned as CSS backgrounds on the following rules: 

 .p7TMM01 a.p7tmm_page 

 .p7TMM01 a.trig_closed 

 .p7TMM01 a.trig_open 

Edit those rules and choose from the selection of icons in the p7tmm/img folder. 

You can also open the p7tmm-globals.png Fireworks file in your Fireworks folder 

and edit the icons. There is also a Fireworks file named p7tmmSee-Through.png, 

which you can use to edit the transparent background image used for the See-

Through style theme. 

  

http://www.projectseven.com/products/tools/accordion/index.htm
http://www.projectseven.com/products/tools/accordion/index.htm
http://www.projectseven.com/products/tools/glidepanel/index.htm
http://www.projectseven.com/products/tools/elevators/index.htm
http://www.projectseven.com/products/tools/tabpanel/demo/index.htm
http://www.adobe.com/products/fireworks/
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Once you complete your edits, export your images back to the relevant p7tmm/img 

folder to overwrite the originals. Use these export settings: 

 

Note: The File name box is irrelevant since you are exporting slices. 
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How do I change the default or hover styles for my links? 

Locate the following rules in your relevant TMM2 style sheet... 

This rule styles the default link state: 

.p7TMMxx ul a 

This rule styles the hover state: 

.p7TMM01 ul a:hover, .p7TMM01 ul a:focus, .p7TMM01 ul a:active 

Your style sheet will usually contain link and hover rules for sub-menu levels, as 

well: 

.p7TMMxx ul ul a 

.p7TMM01 ul ul a:hover, .p7TMM01 ul ul a:focus, .p7TMM01 ul ul a:active 

Change properties and values to suit. 

How do I set the width of my menu? 

TMM2 menus are designed to automatically conform to the width of the container 

in which they are placed, even if that container is a flexible width. If, however, there 

is a need to constrain the menu to a specific width, use the .p7TMMxx rule (it will 

be the first rule in your menu style sheet): 

.p7TMMxx { 

width: 200px; 

}  
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Why are my menu link colors not what I set them to be? 

CSS has an inherent feature called specificity. This means that depending on the 

structure of your page, and the way you've defined your page link styles, your menu 

link styles will sometimes be less specific—allowing the page link styles to take 

precedence. As an example, if you insert a menu inside a DIV with an ID of 

leftcolumn, you might have a CSS rule to style links inside that DIV: 

#leftcolumn a {color: purple;} 

The browser will look at this style and weigh it against your Tree Menu style rule, 

which might be: 

.p7TMM01 ul a {color: #000;} 

An ID reference in a style rule gives that rule higher precedence than one that 

contains only class names—so in this scenario purple wins the battle. 

To correct this issue you can use Dreamweaver's excellent Find and Replace utility 

to change your Tree Menu style rules so that each rule has the ID #leftcolumn at 

the beginning of its name. Here's how: 

Open your menu CSS file. In this case, we'll work with p7TMM01.css 

Choose Edit > Find and Replace... 
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Make sure Find in: Current Document is selected. 

In the Find box enter .p7TMM01 

In the Replace box, enter #leftcolumn .p7TMM01 (making sure there is a space 

between the words) 

Click Replace All 

All your rules will now be prefaced with #leftcolumn 

 

That's it. The colors defined in your menu style sheet will now work just fine. 
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How do I change the appearance of the Current Marked link that 

highlights the page you are on? 

Locate the following rules in your relevant Tree Menu Magic 2 style sheet: 

This rule styles the top-level Current Marked link state: 

.p7TMMxx a.current_mark 

This rule styles the sub-level Current Marked link state: 

.p7TMMxx ul ul a.current_mark 

Change properties and values to suit. 
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Can I style just the first or last link in a menu independently? 

Yes. The TMM2 script dynamically assigns special classes to the first and last <li> 

elements and the first and last <a> elements in your menu, allowing you to set 

exceptions for these elements. These classes will need to be written by you. 

The first and last classes for the <li> element: 

.p7TMMxx li.tmmfirst 

.p7TMMxx li.tmmlast 

The first and last classes for the <a> element: 

.p7TMMxx a.tmmfirst 

.p7TMMxx a.tmmlast 

These classes are useful if, for instance, you want to set a top border on all <li> 

elements except for the first one. To do that you would use the following rule to set 

a top border on all <li> items: 

.p7TMMxx ul li { 

border-top: 1px solid #000; 

} 

Then use this rule to create an exception for the first <li> item: 

.p7TMMxx ul li.tmmfirst { 

border-top: 0; 

} 
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You can also make different exception rules for your sub-menus by creating one or 

more of these selectors: 

 .p7TMMxx ul ul li.tmmlast 

 .p7TMMxx ul ul li.tmmfirst 

 .p7TMMxx ul ul a.tmmlast 

 .p7TMMxx ul ul a.tmmfirst 

How do I style my trigger links? 

Here are the relevant rules: 

 .p7TMMxx a.trig_open (default) 

 .p7TMMxx ul ul a.trig_open (default) 

 .p7TMMxx a.trig_closed (default) 

 .p7TMMxx ul ul a.trig_closed (default) 

The trig_open rules pertain to a trigger link when its respective sub-menu is 

showing. The trig_closed rules pertain to a trigger link when its respective sub-

menu is hidden. 

Are there special styles I can use to assign properties to all links that are not 

triggers? 

Yes. The p7tmm_page class is used in TMM 2 style sheets to assign a special icon 

or bullet to all links that are not triggers. In the Basic style theme, for example, the 

rule looks like this: 

.p7TMM01 a.p7tmm_page { 

background-image: url(img/tmm_page.gif); 

background-repeat: no-repeat; 

background-position: left center; 

} 
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Are there other special CSS classes that can be used? 

There are other special classes you can use to customize your menu. The special 

classes, as used in the Multicolor theme, allow you to key on each root element to 

give it and its sub-levels distinctive characteristics. The following rule from the 

Multicolor style sheet, for example, serves to color the first root menu item yellow: 

.p7TMM09 .root_1 { background-color:#FC0;} 

Each root LI is assigned a root class incremented numerically: 

 root_1 

 root_2 

 root_3 

 etc. 
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Can I add more custom-styled levels to my Multicolor menu? 

Sure. The special classes we use to style each level independently are grouped 

together by root element. Here is the group for the root_5 section: 

.p7TMM09 .root_5 { 

background-color:#AAA; 

} 

.p7TMM09 .root_5 div { 

background-color:#AAA; 

border-top: 1px solid #BEBEBE; 

border-right: 1px solid #9A9A9A; 

border-bottom: 1px solid #9A9A9A; 

border-left: 1px solid #BEBEBE; 

} 

.p7TMM09 .root_5 ul a:hover, .p7TMM09 .root_5 ul a:focus, .p7TMM09 .root_5 ul 

a:active { 

color: #FFF !important; 

} 

.p7TMM09 .root_5 a.trig_open { 

color: #FFF !important; 

text-decoration: underline; 

} 
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By default, we give you 5 custom levels. To add a sixth level add a new group: 

.p7TMM09 .root_6 { 

background-color:#AAA; 

} 

.p7TMM09 .root_6 div { 

background-color:#AAA; 

border-top: 1px solid #BEBEBE; 

border-right: 1px solid #9A9A9A; 

border-bottom: 1px solid #9A9A9A; 

border-left: 1px solid #BEBEBE; 

} 

.p7TMM09 .root_6 ul a:hover, .p7TMM09 .root_6 ul a:focus, .p7TMM09 .root_6 ul 

a:active { 

color: #FFF !important; 

} 

.p7TMM09 .root_6 a.trig_open { 

color: #FFF !important; 

text-decoration: underline; 

} 

Give these new styles the attributes and colors you want. Add more groups, as 

needed. When you're done adding groups, there is a special group selector you 

need to edit, to add your new levels. By default, it looks like this: 

.p7TMM09 .root_1 a, .p7TMM09 .root_2 a, .p7TMM09 .root_3 a, .p7TMM09 .root_4 

a, .p7TMM09 .root_5 a { 

color: #000 !important; 

} 
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If, for example, you added a sixth level, you would edit the above rule to look like 

this: 

.p7TMM09 .root_1 a, .p7TMM09 .root_2 a, .p7TMM09 .root_3 a, .p7TMM09 .root_4 

a, .p7TMM09 .root_5 a, .p7TMM09 .root_6 a { 

color: #000 !important; 

} 

This rule ensures that the colors for all links in your special sections start out black. 

Note that you can selectively override this rule to set a unique color for one or more 

of your custom levels by adding a new rule to your custom group. To make the 

default link color for the root_3 group green, for example, add a new rule 

(highlighted in red below) to your root_3 group: 

.p7TMM09 .root_3 { 

background-color:#EF3A21; 

} 

.p7TMM09 .root_3 div { 

background-color:#EF3A21; 

border-top: 1px solid #F2604A; 

border-right: 1px solid #E22B10; 

border-bottom: 1px solid #E22B10; 

border-left: 1px solid #F2604A; 

} 

.p7TMM09 .root_3 ul a:link, .p7TMM09 .root_3 ul a:visited { 

color: #0F0 !important; 

} 

.p7TMM09 .root_3 ul a:hover, .p7TMM09 .root_3 ul a:focus, .p7TMM09 .root_3 

ul a:active { 

color: #FFF !important; 

} 
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.p7TMM09 .root_3 a.trig_open { 

color: #FFF !important; 

text-decoration: underline; 

} 

If you'd like to override the color of the root_3 trigger links place the new rule at 

the end of the group: 

.p7TMM09 .root_3 { 

background-color:#EF3A21; 

} 

.p7TMM09 .root_3 div { 

background-color:#EF3A21; 

border-top: 1px solid #F2604A; 

border-right: 1px solid #E22B10; 

border-bottom: 1px solid #E22B10; 

border-left: 1px solid #F2604A; 

} 

.p7TMM09 .root_3 ul a:hover, .p7TMM09 .root_3 ul a:focus, .p7TMM09 .root_3 ul 

a:active { 

color: #FFF !important; 

} 

.p7TMM09 .root_3 a.trig_open { 

color: #FFF !important; 

text-decoration: underline; 

} 

.p7TMM09 .root_3 ul a:link, .p7TMM09 .root_3 ul a:visited { 

color: #0F0 !important; 

} 
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How can I adjust the indent of my sub-menus? 

This CSS rules controls menu indentation: 

.p7TMMxx ul ul li { 

padding-left: 1em; 

} 

Can I use images for my menu items? 

Tree Menu Magic supports multi-state image-based menus. Images can be used 

for top-level menu items, sub-menu items, or both. You can even make some links 

images and others text. TMM2 comes with a special style theme that you should 

use when deploying images for the root (top-level) section of your menu: 07-

Image-Based. The system will pre-load the various state images based on the 

selection you make from the Image Swap Options list so be sure to make all the 

images necessary and in accordance with the image naming convention. 

 

Note: The Image Swap Option applies to all images used in a particular menu. While different menus on a 

page can use different options, all links in a specific menu are governed by the option you select for that 

specific menu. 

Image-based examples 

We've prepared some examples of image-based links that you might find 

informative.  

See image-based Examples... 

http://www.projectseven.com/products/menusystems/tmm2/tweaks/image-based/
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My Image Swaps are not working or are showing broken images. 

What's wrong? 

Make sure you are using the correct image naming convention and all required 

images are in the same folder—and that you have set the appropriate Image Swap 

Options in the Tree Menu Magic 2 interface. 

How can I make it so my sub-menus are hidden in Dreamweaver 

Design View? 

Tree Menu Magic sub-menus are visible in Dreamweaver by default. That means 

they are also visible in a browser when JavaScript is disabled, which is an 

accessibility failsafe for customers who do not take any other accessibility 

measures. If you really want to make your sub-menus hidden in Dreamweaver, 

here's how: 

.p7TMMxx div {display: none;} 

Your sub-menus will now be hidden in Dreamweaver and also in browsers when 

script is disabled. 

Can I hide my sub-menus in Dreamweaver and still have an accessible 

site? 

Yes, but you'll have to do some planning and a bit of work. If your sub-menus are 

hidden when script is disabled in a browser, you'll need to make sure that each of 

your trigger links is a real link to a page that contains the links that appear in that 

trigger's sub-menu. 

Is there a place on the PVII site where I can find more TMM2 examples 

or tweaks? 

Yes. We have a special Tweaks and Inspiration folder: Go to TMM2 Tweaks and 

Inspiration... 

http://www.projectseven.com/products/menusystems/tmm2/tweaks/
http://www.projectseven.com/products/menusystems/tmm2/tweaks/
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Support and Contact info 

PVII quality does not end with your purchase - it continues with the best customer 

support in the business. 

PVII Knowledge Base  

The PVII Knowledge Base is an online PVII application allowing you to access dozens 

of Tech Notes, tips, and techniques relating to our products, as well as to general 

web development issues. 

Open the Knowledge Base | View the 10 Most Recent Additions 

  

http://www.projectseven.com/support/questions.asp?type=cat1&id=440
http://www.projectseven.com/support/questions.asp?type=recent
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Newsgroup forum communities 

The Project VII Newsgroup community is our primary support vehicle and is 

available 24 hours a day. Choose from the following newsgroups:  

1. The PVII Webdev Newsgroup 

2. The PVII Dreamweaver Newsgroup 

3. The PVII Fireworks Newsgroup 

4. The PVII CSS Newsgroup 

Note: If you have trouble linking directly to news servers, use your default newsreader's program options to 

set up a new account and point it at the following server: 

forums.projectseven.com 

Setting up a new newsgroup account in Outlook Express 

Setting up a new newsgroup account in Mozilla Thunderbird  

Setting up a new newsgroup account in Entourage  

If you have another newsgroup-capable program that you are using, please see its 

documentation to learn how to add a new newsgroup account. 

Note: PVII newsgroups are private and have nothing to do with Usenet feeds that may be provided by your 

ISP. That is, you will not find our newsgroups in a list of newsgroups distributed by your internet service 

provider. You must set up our news server as a new account.  

  

news://forums.projectseven.com/pviiwebdev
news://forums.projectseven.com/dreamweaver
news://forums.projectseven.com/fireworks
news://forums.projectseven.com/css
http://www.projectseven.com/support/oe.htm
http://www.projectseven.com/support/tbird.htm
http://www.projectseven.com/support/entourage.htm
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RSS News Feeds 

Keep up with the latest news the minute it's released by subscribing to our RSS 

news feed. If you are not sure how to subscribe, please check this page: 

PVII RSS Info 

Before you Contact us 

Before making a support inquiry, please be certain to have read the documentation 

that came with your product. Please include your Dreamweaver version, as well as 

your computer operating system type in all support correspondence. 

E-Mail: 

support@projectseven.com 

Phones:  

330-650-3675 

336-374-4611 

Phone hours are 9:00am - 5:00pm Eastern Time U.S. 

Snail mail 

Project Seven Development 

339 Cristi Lane  

Dobson, NC 27017 

http://www.projectseven.com/xml/index.htm
mailto:support@projectseven.com
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